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[1] INTRODUCTION
Altair Knowledge Hub allows users across organizations and regions to explore, prepare, and distribute data
seamlessly and automatically.
The application allows you to:
❑

Access data from both structured and semi-structured sources, including PDFs, reports, and all major databases,
into orderly tables for subsequent business analytics

❑

Open workspaces saved directly from Data Prep Studio in the Swarm library, a local environment, or shared by
other users

❑

View workspace and table information, including all input data sources, data preparation operations applied,
published tables, exports, and schedules, prior to working with it

❑

Clean and prepare data for visualization or further analysis

❑

Share data from a single-user environment to clustered server environments to deliver the necessary information
to vast communities

❑

Export data to a number of the most popular visualization and advanced analytics tools

❑

Capture data preparations in portable data source definitions, workspaces, and processes to enable easy re-use
and sharing across users and environments

❑

Schedule process execution for automatic data distribution

❑

Enable global collaboration and improve productivity by saving workspaces into the Swarm library for retrieval in
Data Prep Studio or sharing workspaces with other Swarm users

This installation guide describes the steps necessary to install and access Knowledge Hub.
More information on Knowledge Hub is available via the following links:
❑

Knowledge Hub Factsheet

❑

Knowledge Hub Quick Start

❑

Knowledge Hub Online Help

All code indicated in this document must be manually entered wherever necessary to avoid
potential issues with missing/incorrect indentation, invisible characters, and the like. Copying
and pasting code directly from this guide may result in failure to install, deploy, or update
Knowledge Hub for Windows.
WARNING

Knowledge Hub is a highly scalable and flexible application. We strongly advise contacting
your Altair account manager to obtain the recommended specifications for the deployment
you wish to implement. Moreover, we recommend that all procedures to install and deploy
Knowledge Hub for Windows be completed by a knowledgeable system administrator.
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[2] SYSTEM REQUIREMENTS
To run Knowledge Hub successfully, we suggest that your system meet or exceed the minimum requirements
specified below. Administration rights and permissions are required to install Knowledge Hub. Running the application
once installed, however, does not.
In addition, your requirements may vary depending on the volume of data you intend to work with, the number of
concurrent users you expect, and several other factors. Contact us to ask about specific requirements for your
deployment.

MINIMUM REQUIREMENTS
Application Server:
❑

OS: Windows Server 2016 (recommended), Windows Server 2012 R2 64 bit

❑

RAM: 32 GB or higher

❑

Disk Space: 500 GB disk space (depending on the volume of data to be processed)

❑

CPU: 8 cores or higher

❑

Amazon Corretto 11.0.6.10.1 or higher (major version 11, 64-bit; recommended) or Oracle Java JDK 11

❑

For AWS deployments, an m5.2xlarge instance or better

Client Browser (choose one):
❑

Google Chrome (recommended) – latest version

❑

Internet Explorer 11

❑

Mozilla Firefox – latest version

RECOMMENDED SPECIFICATIONS
Knowledge Hub is a highly scalable and flexible application. We strongly advise contacting your Altair account
manager to obtain recommended specifications for the deployment you wish to implement.
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ORACLE JAVA JRE 11 VERSUS AMAZON
CORRETTO 11
While Knowledge Hub 2.4.1 may successfully be deployed with Oracle JDK 11, Altair recommends the use of
Amazon Corretto 11 for new installations of Knowledge Hub. Upgrades of previous versions to Knowledge Hub 2.4.1
will utilize Amazon Corretto or Oracle JDK version 11 or higher. The instructions in this Installation Guide assume that
Amazon Corretto has been installed, but all steps provided are also applicable to instances using Oracle JDK.

PORTS
The following ports must be opened for Knowledge Hub to function correctly:
❑

If you are using HTTP, open port 8080

❑

If you are using HTTPS, open port 8443

When setting up Knowledge Hub on the HTTPS protocol you must map localhost to the host name. However, if you
choose not to, the following ports should be opened:
❑

Port 9091 must be opened to allow the socialization and machine-learning components of the application to work
correctly. When installing the application on AWS, port 9091, as well as all other ports (i.e., 8080 or 8443) must
be added to your AWS instance security group and the port must be open in the server instance.

❑

Port 8081 must be opened for proper communication between the Altair Knowledge Hub service and the Altair
Knowledge Hub Data Engine service.

The protocol type for these ports is TCP.
If mapping localhost to the host name is not done, Knowledge Hub may be installed without errors but usual activities,
such as specifying settings or importing a data source, may yield multiple unexpected error messages.
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[3] RUNNING THE SETUP PROGRAM
The steps below describe how to install Knowledge Hub in a Windows environment.

Steps:
1.

Manually download Amazon Corretto 11 and install it.
While the minimum version required by Knowledge Hub is update 11.0.6.10.1, newer updates are also supported
by the installer (e.g., for minor versions).

2.

Extract the contents of the zip file you obtained from the download link provided by your product specialist. This
file should contain:
•

The application installer

•

A prerequisites folder

The prerequisites folder should include installers for:
•

Altair JDBC Drivers

•

PostgreSQL 11

•

A libs folder containing CDATA JDBC drivers to enable the creation of connections

If any of these items is not in the file you downloaded, contact your Altair product specialist immediately.
3.

Your license will be provided to you by Altair. Rename this file to license.lic and copy it to the folder containing the
Knowledge Hub prerequisites folder and installer.
You may also opt to implement HyperWorks Units-based licensing. To do so, create a new environment variable
with the name ALTAIR_LICENSE_PATH and set its value to “<license server port>@<license server host> (e.g.,
6200@100.0.0.100).
Only one licensing system can be used at any one time.

4.

Double click on the application installer (DatawatchMonarchSwarm.exe) to run it.

5.

In the next screen, read the license agreement. If you agree with its terms, select I accept the agreement and
then click Next.
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6.

The Configuration screen allows you to specify whether the HTTP or HTTPS protocol should be used. The default
port for each protocol is also indicated. Choose the protocol you would like to apply. Unless you want to change
them, accept the default port values indicated and then click Next.

If you wish to use a different set of ports, enter them into the appropriate fields provided and then click Next. The
ports you specify must not be used by other applications.
7.

The Database Configuration screen allows you to specify a database name, a database user name, and a database
user password. The default for all three items is newserver. If you wish to create a new database, user, and
password, enter the required names and passwords into the corresponding fields.
The Database Configuration screen requires you to specify a PostgreSQL administrator login and password to
use for new PostgreSQL installations.

Take note of the administrator login and password you supply as these details will be required when you upgrade
the Knowledge Hub application. If preexisting installation of PostgreSQL is available, the administrator login and
password should be provided here.
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Enter the necessary details and then click Next.
8.

The Select Destination Location screen allows you to specify a folder in which the application will be installed. If
you do not wish to change the default location indicated, click Next. Otherwise, specify a new location and then
click Next.

9.

The Select Components screen allows you to specify which Knowledge Hub components to install.

Deselect the component(s) you do not wish to install and then click Next.
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10. The PostgreSQL Installation Directory screen allows you to specify a folder in which the PostgreSQL will be
installed. If you do not wish to change the default location indicated, click Next. Otherwise, specify a new location
and then click Next.

11. The PostgreSQL Data Directory screen allows you to specify a folder in which the PostgreSQL Data will be stored.
If you do not wish to change the default location indicated, click Next. Otherwise, specify a new location and then
click Next.
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12. The Select Start Menu Folder screen allows you to specify a Start Menu folder into which the program’s shortcuts
will be placed. Change it to a different folder if you wish and then click Next or simply click Next to accept the
default value indicated.

13. The Ready to Install screen provides a summary of your installation folders. Click Install to begin installing
Knowledge Hub.
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The installation begins.

14. When installation has completed, the following message displays. In some cases, you may be asked to restart
your computer. Click Finish to do so.

When the application is correctly installed, the following services become available:
❑

Datawatch Monarch Swarm

❑

Datawatch Monarch Swarm Data Engine

These services refer to the Knowledge Hub and Knowledge Hub Data Engine services, respectively.
While Postgres is automatically installed when Knowledge Hub is installed, this application is reserved for Knowledge
Hub use only. Thus, addition of custom tables/data is not supported.
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Potential Issues with Older Versions of Microsoft Visual C++ Redistributable
When an older version of Microsoft Visual C++ (VC++) Redistributable (e.g., 2012 and older) is installed in a server in
which Knowledge Hub is also to be installed, the following error messages may display:

This issue is due to an incompatibility between the older redistributable package and the VC++ version installed with
the application. To address this issue, simply delete the older version of VC++ and reinstall the application.
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[4] POST-INSTALLATION STEPS
INCREASING THE HEAP SIZE OF THE
APPLICATION
The following procedure represents an important and mandatory post-installation configuration step to increase the
heap size of the application and maximize performance. These instructions should be performed by an experienced
system administrator.
Heap size settings should also be reapplied after an upgrade is performed.

Steps:
1.

Calculate the maximum heap size to allocate to the application. While requirements may vary according to the
environment in which the application is being deployed, a heap size of 75% of the physical memory of the server
is recommended.
For example, if the physical memory of the server is 64 GB, the maximum heap size should be 48 GB.

2.

Modify monarchswarm.xml and monarchswarm-dp.xml as follows, replacing the numerical value of the
parameter “-Xmx16g” with the value calculated in Step 1:

–Xms4g –Xmx16g
For example:

<arguments>-jar "core-api.jar" -Xms4g -Xmx16g -spring.profiles.active=prod</arguments>
where:
“-Xms4g” and “-Xmx16g” indicate the minimum and maximum heap sizes, respectively.

CONFIGURING THE TABLEAU HYPER
COMPONENT FOR EXPORT
Previous versions of Knowledge Hub supported both the Tableau SDK (TDE) and Tableau Hyper (HYPER)
components for exporting data. In the current version of Knowledge Hub, only exports to the Tableau Hyper
component are supported. This component is installed by default in Knowledge Hub v2.3. If the application is installed
via upgrade from an earlier version with a customized Tableau SDK, your Environment Variables must be modified to
switch support for Tableau Hyper.
Older workspaces containing data sources from Tableau SDK are not affected by this change.
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Steps:
1.

In Windows, launch the System Properties dialog (typically by right-clicking on Computer > Properties >
Advanced System Settings) and then click Environment Variables.
The Environment Variables dialog displays.

2.

Edit the Path property in the System variables section of the Environment Variables dialog.

3.

From the list of system variables, delete C:\Program Files\Datawatch Monarch Swarm\tableau_sdk\bin and leave
C:\Program Files\Datawatch Monarch Swarm\tableau_hyper\bin.

4.

Save changes and restart Windows.
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CONFIGURING SETTINGS FOR FILE SYSTEM
CONNECTIONS
In Knowledge Hub 2.4.1, system administrators must specify root (base) paths to file folders to which users can
create connections in the configuration file before File System connections can be made.
Once a base path has been added to the configuration file and the Knowledge Hub services are restarted, this path
becomes visible in the Base Path dropdown provided when creating a File System connection in the application.

NOTE

The connection to a folder may fail if the service account used to run the Knowledge
Hub services does not have access to this folder. In this case, a service account
with the appropriate permissions must be used to restart the application’s services.

Steps:
1.

After installing Knowledge Hub 2.4.1, stop all Knowledge Hub services.

2.

Open the file application-prod.yml, which is typically located in C:\Program Files\Datawatch Monarch Swarm,
and then add the following properties:

IMPORTANT: Base paths are case-sensitive. When specifying a base path to use for file system connections,
ensure that the case for all folder names, including the drive letter, are provided exactly as formatted.
Example:
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NOTES

3.

•

All root paths must be unique.

•

Multiple root paths can be specified by using the properties root-path, root-path2,
root-path3, etc.

•

If multiple paths contain the same start path (e.g., path1: C:\Program
Files\Knowledge Hub\File System1; path2: C:\Program Files\Knowledge Hub\File
System1\Reports), these paths are divided into a root path (i.e., C:\Program
Files\Knowledge Hub\File System1) and an extended path (\Reports).
Connections to these two paths may then be created.

Restart all Knowledge Hub services.

MANAGING CIPHER KEYS
Cipher keys are used in Knowledge Hub for encryption and authentication. These keys must be provided when
restoring Knowledge Hub from a backup.

Extracting Cipher Keys
Encryption keys and auth secret values are provided in the application-prod.yml file and saved during installation.

Updating Cipher Keys
After Knowledge Hub is restored from backup, the application-prod.yml and dp\application-prod.yml files must be
updated with provided (or extracted) cipher keys.

Steps:
1.

Open application-prod.yml and dp\application-prod.yml.

2.

Update application.security.authentication.xauth.secret, application.security.cipher.keyPair.privateKey,
application.security.cipher.keyPair.publicKey values with the provided/extracted values.

3.

Save both files.

4.

Restart the Datawatch Monarch Swarm and Datawatch Monarch Swarm Data Engine services.

5.

Restart the application.
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LOG FILE LOCATIONS
Knowledge Hub log files may be found in the following locations:
LOG FILE

LOCATION

Knowledge Hub service (core-api.log)

%TEMP%\MonarchSwarm\Logs\

Knowledge Hub Data Engine service (data-engineapi.log)

e.g., C:\Windows\Temp\MonarchSwarm\Logs

Installation log files
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The installation log file is saved in the user’s
Temp folder (i.e., the person who ran the installer)
e.g., C:\Users\<User's
name>\AppData\Local\Temp
Installation log files are named as follows:
Setup Log YYYY-MM-DD #NNN.next
where:
YYYY – current year
MM -current month
DD – current day
NNN – a unique number provided to each
installation starting from 1
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[5] STARTING KNOWLEDGE HUB
If you opt not to restart your computer immediately after installing the application, the Knowledge Hub login page
displays as soon as you click Finish on the final screen of the installer.

If you opted to restart your computer after installation or if you are accessing Knowledge Hub from a different
machine, launch your browser, enter the IP address of the machine you are connecting to into the address bar (i.e.,
“10.0.0.101”), and then append the application port specified during installation (in this case “:8080”) to it (e.g.,
“10.0.0.101:8080”). Press Enter on your keyboard afterward.
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The Knowledge Hub login page displays.
If you selected the HTTPS protocol, your address bar should display as follows:

You may need to modify the firewall settings of your server if an error page, such as that shown below, displays when
trying to access the Knowledge Hub login page. Contact your network administrator if this problem persists.

Login using the credentials provided to you by your product specialist and then click Sign in.
The Knowledge Hub dashboard displays.
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[6] SECURITY PROTOCOLS
This section describes how to set up different authentication types for Knowledge Hub.

WARNING

All code indicated in this document must be manually entered wherever necessary to avoid
potential issues with missing/incorrect indentation, invisible characters and the like. Copying
and pasting code directly from this guide may result in failure to install, deploy, or update
Knowledge Hub for Windows.

SETTING UP THE HTTPS PROTOCOL
An SSL certificate is required to run Knowledge Hub installations using the HTTPS protocol. The general steps are as
follows:
1.

Obtain a valid security certificate(s) from a Certificate Authority.

2.

Generate a keystore file from the security certificate(s) issued to you using Java keytool.

3.

Update the Knowledge Hub and Knowledge Hub Data Engine core configuration files to add keystore information.

4.

Restart all Knowledge Hub services.

NOTE

This procedure is best performed by a knowledgeable system administrator.

In the present example, let’s assume that you have a valid signed security certificate bundle purchased from a
Certificate Authority and that this bundle contains a certificate file, key file, and certificate bundle. Let’s name these
files server.crt, server.key, and ca-certs.pem, respectively.
While the steps outlined here use specific certificate file formats, other certificate types may be provided by your
Certificate Authority (e.g., .ca-bundle, .der, .pfx, p7b). Regardless, the basic steps to configure HTTPS for Knowledge
Hub remain the same. More information on how to use Java keytool to generate a keystore may be found here.
In the steps outlined below, the keystore file key-store.jks is generated from the security certificates described
above. If your security certificate is already in .jks format, skip Steps 1 and 2.

Steps:
1.

Install OpenSSL.

2.

Generate a .jks security certificate from the certificates provided by your certificate authority and add the resulting
keystore to the \certificate folder of Knowledge Hub.
2.1 Export the certificate, key, and ca-certificate files to a PKCS12 bundle.

openssl pkcs12 -export -in <certificate file> -inkey <key file> -chain CAfile <certificate bundle> -name <key alias name> -out <PKCS12 file>
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E.g.:

openssl pkcs12 -export -in server.crt -inkey server.key -chain -CAfile cacerts.pem -name knowledgehub.altair.com -out server.p12

2.2 Import the PKCS12 file to a new Java keystore file.

keytool -importkeystore -deststorepass <keystore password> -destkeystore
<keystore name> -srckeystore <PKCS12 file> -srcstoretype PKCS12
E.g.,

keytool -importkeystore -deststorepass altair -destkeystore keystore.jks srckeystore server.p12 -srcstoretype PKCS12

2.3 Copy the keystore file (*.jks) to the \certificate folder of the Knowledge Hub directory (C:\Program
Files\Datawatch Monarch Swarm\certificate).
3.

Update the Knowledge Hub core configuration file and add your keystore information.
3.1 Edit the Knowledge Hub configuration file.
3.1.1 Open application-prod.yml. This file is normally located in C:\Program Files\Datawatch Monarch
Swarm.
3.1.2 Set the following parameters:

server:
port: 8443
ssl:
enabled: true
key-store: <path to generated keystore>
key-store-password: <keystore password>
key-alias: <key alias name>
key-password: <keystore password>
application:
data-engine-api:
url: https://<subdomain>.<domain>.com:8081
Parameter settings:


server.port – The port to use for the HTTPS protocol (8443)



server.ssl.key-store – The path to the generated keystore



server.ssl.key-store-password – The keystore password



server.ssl.key-alias – The key alias name



server.ssl.key- password – The keystore password
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E.g.:

server:
port: 8443
ssl:
enabled: true
key-store: C:\Program Files\Datawatch Monarch
Swarm\certificate\key-store.jks
key-store-password: altair
key-alias: knowledgehub.altair.com
key-password: altair
application:
data-engine-api:
url: https://knowledgehub.altair.com:8081
3.2 Update the Knowledge Hub Data Engine configuration file and add your keystore information.
3.2.1 Open application-prod.yml in the dp folder (C:\Program Files\Datawatch Monarch Swarm\dp).
3.2.2 Set the following parameters:

server:
port: 8443
ssl:
enabled: true
key-store: <path to generated keystore>
key-store-password: <keystore password>
key-alias: <key alias name>
key-password: <keystore password>
application:
core-api:
url: https://<subdomain>.<domain>.com:8443
Parameter settings:


server.port – The port to use for the HTTPS protocol (8443)



server.ssl.key-store – The path to the generated keystore



server.ssl.key-store-password – The keystore password



server.ssl.key-alias – The key alias name



server.ssl.key- password – The keystore password
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E.g.:

server:
port: 8443
ssl:
enabled: true
key-store: C:\Program Files\Datawatch Monarch
Swarm\certificate\key-store.jks
key-store-password: altair
key-alias: knowledgehub.altair.com
key-password: altair
application:
core-api:
url: https://knowledgehub.altair.com:8443
3.3 Restart the Knowledge Hub and Knowledge Hub Data Engine services.
4.

Launch Knowledge Hub in your browser using the following form: https://<ipaddress>:8443.

SETTING UP LIGHTWEIGHT DIRECTORY
ACCESS PROTOCOL (LDAP) AUTHENTICATION
Knowledge Hub supports LDAP authentication. This section describes how LDAP authentication can be implemented
in Knowledge Hub.

NOTE

This procedure is best performed by a knowledgeable system administrator.

Steps:
1.

Stop all Knowledge Hub services.

2.

Open the file application-prod.yml, which is typically located in C:\Program Files\Datawatch Monarch Swarm,
and then add the following properties:
PROPERTY

DESCRIPTION

application.security.authentication.
provider

Use ldap – This propery may be assigned the value
basic or ldap. LDAP can be used with AD.

application.security.authentication.
users-provisioned

Enables (true) or disables (false) explicit
provisioning. If explicit provisioning is disabled, the
system creates Monarch Swam users automatically.
When set to true, users must be created manually
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PROPERTY

DESCRIPTION

application.security.authentication.
ldap.query.attribute-mapping:
login: userPrincipalName
first-name: givenname
last-name: sn
common-name: cn
email: mail
phone-number: telephonenumber
groups: memberOf

Settings used to add users by LDAP query

application.security.authentication.
ldap.query.custom-attributes:
- displayName
- distinguishedName
- name
- objectCategory
- objectClass
- primaryGroupID
- sAMAccountName
- sAMAccountType
- servicePrincipalName
application.security.authentication.
ldap.active-directory

true when AD is used

application.security.authentication.
ldap.domain

Domain name

application.security.authentication.
ldap.domain-users

Allow LDAP authentication for any of two forests in
one domain. The default value for this setting is
FALSE. To authenticate users from just one
domain via LDAP, set this property to TRUE and
then set the correct domain in the property
application.security.authentication.
ldap.domain

application.security.authentication.
ldap.manage-dn
application.security.authentication.
ldap.manage-password

User name and password to use to connect to
LDAP server when ldap-active-directory=false
If ldap-active-directory=true, these properties may
be omitted from the config file.
These credentials are also used to add multiple
users to Knowledge Hub using LDAP query

application.security.authentication.
ldap.search-base

Domain name (e.g., DC=test,DC=local if domain is
test.local)

application.security.authentication.
ldap.search-filter

LDAP configuration

application.security.authentication.
ldap.user-roles

User role(s) for LDAP users

application.security.authentication.
ldap.admin-users

List of users automatically created with the Super
Administrator role in Knowledge Hub (if usersprovisioned: false). When this list is provided, there
is no need to login as an administrator and create
the first LDAP user.

application.security.authentication.
ldap.
group-mapping

True to enable group-mapping in Knowledge Hub;
False to disable
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PROPERTY

DESCRIPTION

application.security.authentication.
ldap.roles-map

Mapping of Knowledge Hub roles to LDAP groups

For example, using the domain and Knowledge Hub server names specified above and assuming that WINSWARMSERVER.test.local is the computer name of the domain controller, the following strings should be
added:

authentication:
provider: ldap
users-provisioned: true
default-password: password
ldap:
query:
attribute-mapping:
login: userPrincipalName
first-name: givenname
last-name: sn
common-name: cn
email: mail
phone-number: telephonenumber
groups: memberOf
custom-attributes:
- displayName
- distinguishedName
- name
- objectCategory
- objectClass
- primaryGroupID
- sAMAccountName
- SAMAccountType
- servicePrincipalName
active-directory: true
domain-users: false
domain: test.local
server: ldap://WIN-SWARMSERVER.test.local/
manage-dn: swarmadmin@test.local
manage-password: Passw0rd#
search-base: DC=test,DC=local
search-filter: "(| (userPrincipalName={0})
(sAMAccountName={0}))"
user-roles:
- 3
admin-users:
- new_user1@test.local
- new_user2@test.local
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In the present example, two users (i.e., new_user1 and new_user2) are assigned the Super Administrator
roles.
The following example shows settings if you wish to implement role/group mapping:

The following behaviors are implemented:

3.

•

If the property users-provisioned is set to true, and the user is not included in the admin-users
list, an error (i.e., “User %user_login% does not exist”) is returned when the user logs into the application. In
this case, the user must be manually added through the User Management page (via LDAP) of Knowledge
Hub.

•

If the property users-provisioned is set to false, and the user exists in Active Directory, a new
user is created upon login to Knowledge Hub. This user’s profile will include a login, last name, and first
name, and s/he will have the role(s) specified in user-roles.

•

If the user exists in Active Directory, and the new user is included in the admin-users list, the user can
log into Knowledge Hub and this user will have the role Super Administrator regardless if the property
users-provisioned is set to either true or false.

Restart all Knowledge Hub services.
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SETTING UP SECURITY ASSERTION MARKUP
LANGUAGE (SAML) AUTHENTICATION
Knowledge Hub supports SAML authentication. The following general steps must be carried out to configure SAML
for Knowledge Hub.

NOTE

This procedure is best performed by a knowledgeable system administrator.

Steps:
1.

Download and install Amazon Corretto 11.0.4+ (e.g. 11.0.7).

2.

Configure Okta IDP.

3.

Configure SAML properties in the Knowledge Hub config file.

4.

Restart the Knowledge Hub service.

Details of Steps 2 and 3 are described below.

Configuring Okta IDP
Steps:
1.

Login to your Okta account. The Developer Console displays as the default view.

2.

Click the upper left-hand corner of this console, and then choose Classic UI.

3.

In the dashboard that displays, click Add Applications.
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4.

Click Create New App.

5.

In the dialog box that appears, select SAML 2.0, and then click Create.

6.

In the General Settings section, enter Spring Security SAML in the App name box and then click Next.
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Next, you must configure your SAML settings.
7.

In Part A of the Configure SAML section, paste the following URLs
•

Single sign on URL: <kh-host>/saml/SSO (e.g., https://bp-south.aws.devaltair.com:8443/saml/SSO)

•

Audience URI (SP Entity ID): <kh-host>/saml/metadata (e.g., https://bp-south.aws.devaltair.com:8443/saml/metadata)

Important: The URI indicated should match the value specified for application.security.
authentication.saml.local-entity-id in the Knowledge Hub config file.
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8.

(REQUIRED) Configure SAML user attributes.
For user creation, Knowledge Hub requires the following attribute names mapped in the configuration file:
•

Login – login

•

First name – firstName

•

Last name – lastName

•

Email – emailAddress

Add the following attribute statements:

You can modify these attributes at a later time by going to Applications > <Your APP> > General > SAML
Settings > Edit > Configure SAML > Attribute Statements in Okta.
9.

(OPTIONAL) Configure SAML groups.
Role mapping to groups for Knowledge Hub may be configured in Okta. To do so, specify mappings for groups in
the Group Attribute Statements section.

These groups will be mapped to the Knowledge Hub config file. You can modify these attributes at a later time by
going to Applications > <Your APP> > General > SAML Settings > Edit > Configure SAML > Group
Attribute Statements in Okta.
10. Click Next when you are finished.
Your SAML configuration is completed and saved.
11. To complete role mapping for groups, go to Applications > <Your APP> > Assignments and assign the
application to groups.
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Configuring SAML Properties in the Knowledge Hub Config File
Steps:
1.

(REQUIRED) Generate a .jks keystore keypair and copy this file to the setup folder. You must use at least jdk
Amazon Corretto 11.0.4.+ for the keytool command.

#!/bin/bash
ALIAS=privatekeyalias
CERTIFICATE_FILE=certificate.cer
KEYSTORE_FILE=saml-keystore.jks
keytool -genkeypair -alias $ALIAS -keypass samplePrivateKeyPass
-keystore $KEYSTORE_FILE -keyalg RSA -sigalg SHA256WithRSA
keytool -exportcert -keystore $KEYSTORE_FILE -alias $ALIAS file $CERTIFICATE_FILE

$ bash jks-generator.sh
Enter keystore password: secret
Re-enter new password: secret

You will need to save two values that will be used by KnowledgeHub: the alias and the key-store password.
These values should be saved to create secrets.
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As outputs, you will receive two files: saml-keystore.jks and certificate.cer.
Note: The key and signature algorithms supplied for keypair generation should match the values provided in the
Okta application configuration, for example, -keyalg RSA -sigalg RSA-SHA256WithRSA.
To check these values, in Okta, go to Applications > <Your APP> > General > SAML Settings > Edit >
Configure SAML > Show Advanced Settings.

2.

(OPTIONAL) Create an empty saml-metadata.xml file to read file-based IDP metadata.

3.

(REQUIRED) Open the file application-prod.yml, which is typically located in C:\Program Files\Datawatch
Monarch Swarm, and then add the following properties:

application:
security:
authentication:
provider: saml
users-provisioned: <true/false>
saml:
ssl:
key-store: <path to keystore.jks>
key-store-password: <keystore password>
key-alias: <alias>
local-entity-id: <SP entity ID>
file-metadata: <true/false>
idp-metadata-url: <idp metadata url>
idp-metadata-file-path: <path to idp metadata file>
signing-algorithm: <signing algorithm>
response-skew-in-sec: <time in seconds>
max-authentication-age: <time in seconds>
authn-request-binding: <binding value>
single-logout: <true/false>
user-roles:
- <default user role>
admin-users: <admin user>
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attribute-mapping:
login: login
first-name: firstName
last-name: lastName
email: emailAddress
role-mapping: <true/false>
rolesmap: <role mapping to groups>

Default Properties
PROPERTY

DESCRIPTION

local-entity-id

The value provided in Audience URI (SP Entity ID) in Okta

file-metadata

Boolean property to enable file-based metadata source. If set to
true, Knowledge Hub will use saml-metadata.xml for
Service Provider (SP) configuration.

idp-metadata-url

The IDP public metadata URL.
To obtain this value, go to Applications > <Your APP> > Sign
On > Identity Provider Metadata.
Click on the Identity Provider metadata link. The URL in the
address bar of the popup window is your idpMetadataUrl (e.g.,

https://dev-20573.okta.com/app/
exkhbq6uo1auBFrIs4x6/sso/saml/metadata)
attribute-mapping

Mapping between assertion attributes and Knowledge Hub users
to create.

user-roles

Default user roles for Knowledge Hub user creation in the case
when role-mapping is set to false or no groups are specified in
the attribute statements

role-mapping

Boolean property to enable role mapping against SAML attribute
statements

rolesmap

Mapping for SAML assertion roles.

singleLogout

Boolean property to enable Single Logout for Knowledge Hub.
This property must be set to true if single logout is to be
enabled.

Additional SAML Properties
PROPERTY

DESCRIPTION

idp-metadata-file-path

File path for file-based IDP metadata.
Default value: /saml/saml-metadata.xml

signing-algorithm

Sets the signing algorithm to use when signing the SAML
messages.
Default value : http://www.w3.org/2001/04/

xmldsig-more#rsa-sha256

response-skew

max-authentication-age

Sets the maximum difference between local time and time of the
assertion creation which still allows message to be processed.
Basically determines maximum difference between clocks of the
IDP and SP machines. Default value: 60s

Sets maximum time between users authentication and
processing of an authentication statement.
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PROPERTY

DESCRIPTION
Default value: 7200s
Sets binding to be used for sending SAML messages to the IDP.
Default value:
❑

urn:oasis:names:tc:SAML:2.0:
bindings:HTTP-POST

Possible values:

authn-request-binding

❑

urn:oasis:names:tc:SAML:2.0:
bindings:HTTP-POST

❑

urn:oasis:names:tc:SAML:2.0:
bindings:HTTP-Redirect

❑

urn:oasis:names:tc:SAML:2.0:
bindings:PAOS

❑

urn:oasis:names:tc:SAML:2.0:
profiles:holder-of-key:SSO:
browser

For example:

application:
security:
authentication:
provider: saml
users-provisioned: false
saml:
ssl:
key-store: C:\saml\saml-keystore.jks
key-store-password: secret
key-alias: privatekeyalias
local-entity-id: https://bp-south.aws.dev-

altair.com:8443/saml/metadata
file-metadata: false
idp-metadata-url: https://dev527674.okta.com/app/axbeg4pna35cIczd24x6/sso/saml/metadata
idp-metadata-file-path: C:\saml\saml-metadata.xml
signing-algorithm: http://www.w3.org/2001/04/xmldsigmore#rsa-sha256
response-skew-in-sec: 10s
max-authentication-age: 10s
authn-request-binding:
urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST
user-roles:
- 2
admin-users: admin1@altair.com
attribute-mapping:
login: login

first-name: firstName
last-name: lastName
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email: emailAddress
role-mapping: true
roles-map:
8: Admin
3: Analyst

Other Optional Settings
Configuring Single Logout
Steps:
1.

Go to Applications > <Your APP> > General > SAML Settings > Edit > Configure SAML > Show Advanced
Settings.

2.

Tick the box provided to Enable Single Logout.

3.

Add the following parameters:
•

Single Logout URL: <kh-host>/saml/SingleLogout (e.g., https://bp-south.aws.devaltair.com:8443/saml/SingleLogout)

•

SP Issuer: This value should be identical to Audience URI (SP Entity ID) provided in the Okta SAML
configuration

•

Signature Certificate: Upload the certificate.cer file obtained when you generate your .jks keystore
keypair

4.

To enable this feature in Knowledge Hub, the singleLogout property in the config file must be set to true;
otherwise, SLO will not be implemented.

5.

Save your settings.
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Configuring Assertion Encryption
Steps:
1.

Go to Applications > <Your APP> > General > SAML Settings > Edit > Configure SAML > Show Advanced
Settings.

2.

Enable the Assertion Encryption option.

3.

Provide the corresponding encryption algorithm and key transport algorithm.

4.

Save your settings.

SETTING UP OAUTH2.0 AUTHENTICATION
Knowledge Hub users may be authenticated through OAuth 2.0, which can be configured using several identity
providers, including Azure Active Directory. User provisioning can be created either automatically or explicitly.

NOTE

This procedure is best performed by a knowledgeable system administrator.

The steps outlined in this section assume that:
❑

A user from Azure AD is mapped to a Knowledge Hub user by login.

❑

A user with such a login exists in Knowledge Hub.

The following steps summarize how to set up OAuth 2.0 and use with Azure AD.

Registering the Knowledge Hub Application to Azure Active Directory
Steps:
1.

Sign in to the Azure portal.

2.

In the left-hand navigation pane, select the Azure Active Directory service, and then select App registrations >
New registration.

3.

When the Register an application page appears, enter your application's registration information:
•

Name - Enter a meaningful application name that will be displayed to users of the app.

•

Supported account types - Select which account you would like your application to support.
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•



Accounts in this organizational directory only – Select this option if you are building a line-ofbusiness (LOB) application. This option is not available if you are not registering the application in a
directory. This option maps to Azure AD only single-tenant.



Accounts in any organizational directory - Select this option if you would like to target all business
and educational customers. This option maps to an Azure AD only multi-tenant.



Accounts in any organizational directory and personal Microsoft accounts - Select this option to
target the widest set of customers. This option maps to Azure AD multi-tenant and personal Microsoft
accounts.

Redirect URI – <kh-host>/login/oauth2/code/knowledgehub

4.

When finished, select Register.

5.

Copy the Application ID from the app's Overview page. This ID is the client_id, which you will need to modify
the config file.

6.

Select the Certificates & Secrets section from the app's Overview page.

7.

Select New client secret.

8.

Add a description for your client secret, select a duration, and then click Add.

9.

After saving the configuration changes, the right-most column will contain the client_secret value, which you will
need to update the Knowledge Hub config file.

More information on registering an app on Azure AD can be found in https://docs.microsoft.com/en-us/azure/activedirectory/develop/quickstart-register-app.

Modifying the Knowledge Hub Config File
Open the file application-prod.yml, which is typically located in C:\Program Files\Datawatch Monarch Swarm, and
then add the following properties.
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where:
❑

application.server.internet-address – is the URL of the Knowledge Hub server

❑

application.security.authentication.oauth2.client.clientId – is the client ID

❑

application.security.authentication.oauth2.client.clientSecret – is the client secret

❑

application.security.authentication.oauth2.user-roles – default role of users added to Knowledge Hub

❑

application.security.authentication.oauth2.admin-users – users with the Super Administrator role in
Knowledge Hub

❑

application.security.authentication.oauth2.attribute-mapping – settings used to add users by Azure AD
query

For example:

application:
server:
internet-address: https://win-1abcde2fgh3.altair.com:8080
security:
authentication:
provider: oauth2
users-provisioned: false
default-password: defaultPassword
oauth2:
client:
clientId: 123456a-78bc-9d10-e11f-1213g5ade9c3
clientSecret: =Q7abcS[d=]e2F3GhiJklMNoP4.q2r8S
accessTokenUri:
https://login.microsoftonline.com/common/
oauth2/token
userAuthorizationUri:
https://login.microsoftonline.com/
common/oauth2/authorize
jwkUri: https://login.microsoftonline.com/common/
discovery/keys
scope:
openid,https://graph.microsoft.com/user.read
resource:
userInfoUri: https://graph.microsoft.com/v1.0/me
user-roles:
- 2
admin-users: admin@altair.com
attribute-mapping:
login: upn
first-name: given_name
last-name: family_name
email: upn
phone-number: telephonenumber

Save all changes made to the application-prod.yml file and restart both Knowledge Hub services.
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Using OAuth 2.0
Steps:
1.

GET http://<kh-host>/api/latest/config
RESPONSE

2.

If

application.security.authentication.provider

equals

oauth2,

then

open

<kh-host>/

<application.security.authentication.oauth2.authorization-url>

CONFIGURING LICENSING OPTIONS
Licensing Types
Knowledge Hub supports two types of licensing:
❑

File licensing – Uses a license file provided by Altair. The license file contains a predefined number of users,
data usage, and available features. Thus, the number of users that can be created and the number of rows that
can be imported into the application are limited by the definitions provided in the license file.

❑

HyperWorks Units (HWU) licensing – Uses the Altair License Server based on HWUs to limit the number of
users that can access the application simultaneously. In this case, each user “borrows” a certain number of units
from the server when s/he starts working with Knowledge Hub and then releases these units when the session
has been completed.

Licensing Knowledge Hub Using HyperWorks Units
The steps provided in Page 4 describe how to install Knowledge Hub via a license file.
The steps below describe how to install Knowledge Hub using HWU licensing.

Steps:
1.

Run the installer and install Knowledge Hub as usual.

2.

Edit application-prod.yml and add the following properties:
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3.

Restart the Knowledge Hub services.

Changing the Licensing Type
The steps below describe how to change licensing types in Knowledge Hub.

A. From File Licensing to HWU Licensing
Steps:
1.

Edit application-prod.yml and add the following properties:

2.

Restart the Knowledge Hub services.

B. From HWU Licensing to File Licensing
Steps:
1.

Add the license file license.lic to the Knowledge Hub folder (typically C:\Program Files\Datawatch Monarch
Swarm) and then update application-prod.yml file as follows:

2.

Restart the Knowledge Hub services.
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[7] CONFIGURATION FILE SETTINGS
KNOWLEDGE HUB APPLICATION
Knowledge Hub’s core configuration file, named application-prod.yml, is typically created and stored in C:\Program
Files\Datawatch Monarch Swarm. A snippet of the contents of this file is shown below.

Upon installation of the Knowledge Hub application, your configuration file will only include settings for the connection
to the Knowledge Hub database, the server port, and the SSL certificate (if this option is selected during installation).
The following table describes, in detail, the properties that may be added to this configuration file.
PROPERTY

DESCRIPTION

SPRING

spring.datasource.url
spring.datasource.username
spring.datasource.password

Describes the connection to the Postgres database
for the Knowledge Hub service

spring.http.multipart.maxFileSize
spring.http.multipart.maxRequestSize

Describes the maximum size of files that may be
uploaded to the application (e.g., 2000MB)

LOGGING

logging.file

Full path to the Knowledge Hub application log file

logback.loglevel

Logging level of the Knowledge Hub application log
file

SERVER

server.port
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PROPERTY

DESCRIPTION

server.ssl.enabled
server.ssl.key-store
server.ssl.key-store-password
server.ssl.key-password

Describes properties for the SSL certificate

server.tomcat.accesslog.enabled
server.tomcat.accesslog.directory
server.tomcat.accesslog.accept-count
server.tomcat.accesslog.buffered
server.tomcat.accesslog.pattern
server.tomcat.accesslog.prefix
server.tomcat.accesslog.renameon-rotate
server.tomcat.accesslog.requestattributes-enabled
server.tomcat.accesslog.rotate
server.tomcat.accesslog.suffix

These items describe settings for Tomcat logs:
•

buffered - Buffer output so that it is flushed
periodically

•

pattern - Format pattern for access logs

•

prefix - Log filename prefix

•

rename-on-rotate – Defer inclusion of the date
stamp in the filename until rotate time

•

request-attributes-enabled – Set request
attributes for IP address, hostname, protocol,
and port used for the request

•

rotate – enable access log rotation

•

suffix – Log filename suffix

APPLICATION

application.server.internet-address

Specifies the <protocol>://<server>:
<port> of the authorized redirect URL for login to
Salesforce, Google Analytics, Google Adwords,
etc. The redirect URL should be identical to the
URL specified for ClientId and ClientSecret for
Google connections.
For example, if the authorized redirect Uri is

https://bp-south.swarm.devaltair.com:8443/connections/
oauthRedirectUrl, the value
https://bp-south.dev-altair.com:
8443 should be specified for this property.
application.http.cache.timeTo
LiveInDays

Describes the amount of time in days that may
elapse before a data source’s cache times out

application.data-engine.store.
design-mode-limit

Describes the row limit to be used for data sources
in Design Mode; the default value is 10K

application.data-engine.store.
global-row-limit

Row limit applied when the Design Mode limit is
disabled
e.g., 5000

application.data-engine-api.url

URL for internal communication between the
Knowledge Hub and Knowledge Hub Data Engine
services (http://<machine name>:8081).
You can change the port on which the Data Engine
will run by specifying a different port number for
this property. The value you enter must match the
value provided for the server.port property in the
Knowledge Hub Data Engine config file. Both
services must be restarted when this property is
updated.

application.dsl.source-cleaner-cron
application.dsl.source-expirationin-hours
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PROPERTY

DESCRIPTION

application.dsl.temporary-itemcleaner-cron
application.dsl.temporary-itemexpiration-in-hours
application.dsl.process-run-cleanercron
application.dsl_process-run-cleanerexpiration-time
application.license.provider

Type of license provider; can be “local”, “remote”,
or “hwu”

application.license.local.filepath

Path to license.lic file

application.license.remote.url

URL to the remote server

application.license.hwu.host

Altair License Server address. Should be written as
“<port>@<host>”. The URL to the Altair License
Server should be set as an environment variable.

application.license.hwu.checker-cron

Schedule to execute remote license pool check
(e.g., 00/5 * * * *)

application.license.hwu.group

Name of group on Altair License Server (e.g.,
${COMPUTERNAME}). This property should also
be set as an environment variable.

application.license.hwu.log.enabled

Enable (true) or disable (false) hwu logging

application.license.hwu.log.level

Level of hwu logging (e.g., info)

application.license.hwu.log.facility

Type of output (e.g., stderr)

application.io.connection.disabled

Specifies which connection types to disable (hide)
in Knowledge Hub for all users

application.io.internal-storagefolder

Describes the path to the application’s internal
storage (i.e., File Library; default:
${ProgramData}\Datawatch\DNS\
InternalStorage

application.io.connection.filesystem.root-paths.root-path

C:\ProgramFiles\Datawatch Monarch
Swarm\File_System
Specifies which file folders to expose when
creating File System connections. If root paths are
not specified in the config file, Knowledge Hub
users will not be able to create File System
connections because a base path is required for
this type of connection.

application.security.authentication.
xauth.tokenValidityInSeconds

Describes how many seconds should elapse
before a user times out
e.g., 1800

application.schedules.monitoring.
intervalInMinutes

Number of minutes that must elapse before the
next monitoring operation should be executed in a
monitoring schedule

application.security.authentication.
failed-attempt-min-delay-sec

Delay after the first failed login attempt
e.g., 8

application.security.authentication.
failed-attempt-max-delay-sec

Maximum delay time after a failed login attempt
e.g. 600
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KNOWLEDGE HUB DATA ENGINE
Settings for the Knowledge Hub Data Engine service are specified in C:\Program Files\Datawatch Monarch
Swarm\dp\application-prod.yml. A snippet of the config file is provided below:

The following table describes, in detail, the properties that may be added to this configuration file.
PARAMETER

DESCRIPTION

SPRING

spring.datasource.url
spring.datasource.username
spring.datasource.password

Describes the connection to the Postgres database
for the Knowledge Hub service

LOGGING

logging.file

Full path to Data Engine service log file

logback.loglevel

Logging level of the Data Engine service log file

SERVER

server.port

8081 – port on which the Data Engine is running
You can change the port on which the Data Engine
will run by specifying a different port number for
this property. The value you enter must match the
value provided for the application.data-engineapi.url property in the Knowledge Hub core config
file. Both services must be restarted when this
property is updated.

server.ssl.enabled
server.ssl.key-store
server.ssl.key-store-password
server.ssl.key-password

Describes parameters for the SSL certificate.
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PARAMETER

DESCRIPTION

APPLICATION

application.data-engine.postgres.
copy-interface-enabled

Setting to specify which method to use (i.e., COPY
or ResultSet) when loading data from Postgres
during export so that the operation is completed
faster.
true/false – if the value true is selected, the COPY
interface is used. Otherwise, the ResultSet read
method is used.

application.data-engine.postgres.
reader-buffer-size

Specifies the buffer size to use when reading data
from Postgres (e.g., 80 MB).

application.data-engine.store.
statistics-await-timeout

Time to wait before statistics requests time out
e.g., 60s

application.data-engine.store.
column-limit

100 - column limit after Pivot and Transpose.

application.data-engine.store.
distinct-value-limit

250 - number of displayed distinct values limit

application.data-engine.store.
limit-data-nodes

Enables or disables limit to count of rows in all data
nodes
e.g., true (enabled); false (disabled)

application.data-engine.store.
export-data-await-timeout-in-sec

3600 - export timeout

application.server.internetaddress

Specifies the <protocol>://<server>:
<port> of the authorized redirect URL for login to
Salesforce, Google Analytics, Google Adwords,
etc. The redirect URL should be identical to the
URL specified for ClientId and ClientSecret for
Google connections.
For example, if the authorized redirect Uri is

https://bp-south.swarm.devaltair.com:8443/connections/
oauthRedirectUrl, the value
https://bp-south.dev-altair.com:
8443 should be specified for this property.
application.io.internal-storagefolder

InternalStorage - Specifies the folder were internal
exports are stored.
By default, internal data source files are stored in
ProgramData\Datawatch\
DNS\InternalStorage

application.security.
authentication.xauth.secret

Security token; should be equal to all other security
tokens in all other application config files

application.core-api.url

Address for internal communication with the
Knowledge Hub service.

WRITER

application.io.writer.cognos.httpclient.timeout

Describes the time in seconds that may elapse
before connections to IBM Cognos Analytics time
out
e.g., 600

READER

application.io.reader.preview.limit
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PARAMETER

DESCRIPTION

JDBC SETTINGS

application.io.reader.jdbc.fetchsize

Describes the number of rows to fetch for a query
to a database using JDBC drivers, e.g., 200

application.io.reader.jdbc.timeoutin-sec

Describes the time in seconds that may elapse
before connections to JDBC drivers time out (e.g.,
60)

application.io.reader.jdbc.driver.*

Configuration settings for JDBC drivers

application.io.reader.jdbc.
driver.default.loginTimeout

Describes the time in seconds that may elapse
before connections to JDBC drivers time out after
login (e.g., 60)

application.io.reader.jdbc.
driver.default.socketTimeout

Describes the time in seconds that may elapse
before a socket timeout occurs when using
connections to JDBC drivers
e.g., 60

application.io.reader.jdbc.
driver.cdata.jdbc.all.timeout

Describes the time in seconds that may elapse
before all connections to JDBC drivers time out
(e.g., 60)

application.io.reader.jdbc.
driver.com.mysql.jdbc.Driver.
useCursorFetch
application.io.reader.jdbc.
driver.com.mysql.jdbc.Driver.
loginTimeout
application.io.reader.jdbc.
driver.com.mysql.jdbc.Driver.
socketTimeout

Settings for mySQL JDBC driver

application.io.reader.jdbc.
driver.oracle.jdbc.OracleDriver.
oracle.net.CONNECT_TIMEOUT
application.io.reader.jdbc.
driver.oracle.jdbc.OracleDriver.
oracle.jdbc.ReadTimeout

Settings for Oracle JDBC driver

application.io.reader.jdbc.
driver.com.facebook.presto.jdbc.
PrestoDriver.SSL
application.io.reader.jdbc.
driver.com.facebook.presto.jdbc.
PrestoDriver.password

Settings for Presto JDBC driver

application.io.reader.jdbc.
driver.org.apache.hive.jdbc.Hive
Driver.java.security.krb5.conf
application.io.reader.jdbc.
driver.org.apache.hive.jdbc.Hive
Driver.java.security.auth.login.
config

Settings for Apache Hive JDBC driver

REPORT TRAPPING

application.trapping.report-textview-max-cache-in-mb

This option sets the limit in megabytes for storing
the converted reports.

application.trapping.report-textview-max-cache-count

This option sets the limit in counts for storing the
converted reports.

Altair Knowledge Hub Windows Installation Guide

44

PARAMETER

DESCRIPTION

application.trapping.report-textview-number-of-pages

If the page number of the report exceeds this
setting, then conversion option converts from PDF
reports to TXT report
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[8] UPGRADING KNOWLEDGE HUB
Knowledge Hub 2.4.1 uses Apache Avro and Amazon Corretto 11. If your Knowledge Hub version is 2.3.2 and you
wish to upgrade to version 2.4.1, you may need to migrate your internal tables from Cassandra to the new format so
that you can use them after you upgrade. Upgrading from Oracle JDK 11 to Amazon Corretto 11 is also
recommended.
We further recommend that you clear the /libs folder (but retain any “custom” drivers you may have added) before
updating Knowledge Hub. Upgrading the application does not remove outdated drivers from this folder and may
cause issues (e.g., the application will not start or some connections cannot be completed) when the application is
run.

MIGRATING INTERNAL TABLES IN CASSANDRA
TO APACHE AVRO
This migration process transfers internal export data from the Cassandra database of Knowledge Hub 2.3.2 to the
new internal export format in Apache Avro in Knowledge Hub 2.4.1.
Migration should be done before the actual upgrade to 2.4.1 to keep the process as simple as possible.

Preparation
Steps:
1.

Download cassandra-migrator.jar here.

NOTE

When the cassandra-migrator.jar file is downloaded by using Internet Explorer
11, it is added to a .zip file. Unzip this file to extract its contents prior to
proceeding.

2.

Verify that you have Java installed. You can do so through the command prompt. Enter the command java version and observe the response. You should have at least Java 8 installed.

3.

Verify that you have the Cassandra service running. Open the “Services” console and search for the service
cassandra. The service should have a “Running“ status. If it is not running, manually start it.

4.

Locate the cassandra-migrator-2.3.2.jar file and open the command prompt (cmd.exe) as Administrator in this
folder. You should run the jar with admin permissions to avoid access issues.
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Usage
Steps:
1.

Open cmd.exe in the folder with a migrator.

2.

Run the command java -jar cassandra-migrator-2.3.2.jar.

3.

Wait for completion.

4.

Check the InternalStorage path for created files (C:\ProgramData\Datawatch\DNS\InternalStorage by default).

5.

Perform upgrade procedures to upgrade Knowledge Hub to the 2.4.1 version.

If Knowledge Hub was updated to version 2.4.1 prior to migration of internal tables, follow the steps below. The
Cassandra service is disabled by default after upgrading to this version of the application.

Steps:
1.

Open the Services console.

2.

Find the service named Cassandra, right-click on this service and then choose > Properties > Startup type.

3.

Update the Startup type to Manual and then click Apply.

4.

Start the service.

5.

Double-check all items in the Preparation list.

6.

Perform all steps in the Usage list.

UPGRADING AMAZON CORRETTO
The Amazon Corretto in the server in which Knowledge Hub has been installed can be upgraded. To do so, download
the new JDK version from the official Amazon site, uninstall the old JDK version, and then install the new one.
Proceed with running the installer or upgrading Knowledge Hub.
Alternatively, the steps below describe how to upgrade Amazon Corretto if the Knowledge Hub application is not
going to be upgraded or reinstalled.

Steps:
1.

Stop all of the related Knowledge Hub services.

2.

Go to Control Panel\System and Security\System and select Advanced system settings.

3.

In the System Properties dialog that displays, click Environment Variables.

4.

Check that the PATH variable under System variables displays the path to the latest Corretto /bin folder (e.g.,
C:\Program Files\Amazon Corretto\jdk11.xx\bin) as the first item in the list. If not, modify this variable to reflect the
necessary path.
For example, if the current path reads “C:\Program Files\Amazon Corretto\jdk11.0.4_10\bin” and your Amazon
Corretto version is upgraded to jdk11.0.5_10, change the path to "C:\Program Files\Amazon
Corretto\jdk11.0.5_10\bin" and then click OK on the Edit System Variable dialog to close it.
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5.

Click OK on the Environment Variables and System Properties dialogs to close them.

6.

Check that the new path is applied by running the command java -version.
If the old version of Amazon Corretto is returned in the result, reboot the server.

7.

In C:\Program Files\PostgreSQL\11\pgAdmin 4\bin, double-click on the pgAdmin4 application to launch it.
The pgAdmin4 user interface displays in your browser.
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8.

Connect to the PostgreSQL 11 server using the default user "postgres" and password "postgres."

9.

Locate the database newserver_dataengine > Schemas > public.

10. Open the Query Tool by right-clicking on the schema public and then selecting Query Tool from the options that
display.

11. Execute the following script:
SET pljava.libjvm_location TO 'path';
ALTER DATABASE newserver_dataengine SET pljava.libjvm_location FROM CURRENT;
where path is the path to the jvm.dll file of the upgraded JDK (e.g., C:\Program Files\Amazon
Corretto\jdk11.xx\bin\server\jvm.dll)

NOTE

To verify that the correct pljava.libjvm location had been specified, run the
command SHOW pljava.libjvm_location in pgadmin. The current pljava.libjvm
location displays.

12. Execute this script by clicking the Execute/Refresh (F5)
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13. Close pgAdmin4 and restart the Knowledge Hub service.

If your Knowledge Hub application was installed using the HTTPS protocol and
Amazon Corretto was upgraded, you must generate a new security certificate.
Click here for instructions on how to obtain this certificate and configure client
machines.
NOTES

IMPORTANT: When upgrading to Knowledge Hub version 2.4.x from a lower
version of the application, the JDK upgrade procedure must be completed prior
to the application upgrade. If not done in this order, the installer may encounter
issues when migrating data from PostgreSQL 9.6 to 11.

UNINSTALLING THE KNOWLEDGE HUB
APPLICATION
Knowledge Hub may be uninstalled prior to upgrading it.

Steps:
1.

In the folder Control Panel > Programs > Uninstall a program, locate the Knowledge Hub application, rightclick on it, and then select Uninstall from the menu that displays.

2.

Click Yes on the message box that displays.
Knowledge Hub is uninstalled.

3.

Uninstall the Datawatch JDBC drivers and PostgreSQL.
Other applications besides Knowledge Hub may require PostgreSQL to run correctly. Consult your system
administrator before uninstalling the program. Information on how to completely remove PostgreSQL from your
server may be found online.

4.

Restart your computer.
A newer version of Knowledge Hub may now be installed.
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UPGRADING THE KNOWLEDGE HUB
APPLICATION
To gain access to Knowledge Hub’s newer features, you must upgrade the application. Cached data sets are reset
when upgrades are performed. Statistics are not reset.
To upgrade your Knowledge Hub installation, simply run the installer of the newer version of the application. While no
uninstallation of the previous version is necessary, the Knowledge Hub and Knowledge Hub Data Engine services
must be stopped prior to the upgrade.

Steps:
1.

Double-click on the application installer to run it.

2.

Read the license agreement that displays in the next screen and, if you agree with its terms, select the button for I
accept the agreement. Click Next when you are finished.

The Database Configuration screen displays.
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3.

In the fields provided, enter the PostgreSQL administrator login and password that were provided when the
older version of Knowledge Hub was installed.

4.

Click Next when you are finished.
The Select Components screen displays.

5.

If you wish to make changes to the components you had previously installed, you can do so now. Otherwise, simply
click Next.
The Ready to Install screen displays.

6.

Click Install.
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The installation begins.

7.

After installation, the following screen displays.

8.

Click Finish.
The Knowledge Hub login page displays.

9.

If you wish to implement HyperWorks Units-based licensing, stop all Knowledge Hub services. Create a new
environment variable with the name ALTAIR_LICENSE_PATH and set its value to “<license server port>@<license
server host> (e.g., 6200@100.0.0.100). Restart all services and log in to Knowledge Hub as usual.
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UPDATING THE CONFIGURATION FILE FOR
FILE SYSTEM CONNECTIONS
Previous versions of Knowledge Hub allowed users with the appropriate privileges (i.e., users with the roles
Administrator, Super Administrator, or Advanced) to create connections to file systems straightaway. However, in
Knowledge Hub 2.4.1, system administrators must specify root (base) paths to file folders to which users can create
connections in the configuration file before these connections can be made. This improvement provides greater
system security but also requires some work when upgrading from a lower version of the application.
Specifically, base paths must be provided for all file system connections created in previous versions of Knowledge
Hub to be able to continue using these connections and accessing the necessary data sources from these
connections in Knowledge Hub 2.4.1. In addition, the connection to a folder may fail if the service account used to run
the Knowledge Hub services does not have access to this folder. In this case, a service account with the appropriate
permissions must be used to restart the application’s services.

Steps:
1.

After upgrading to Knowledge Hub 2.4.1, stop all Knowledge Hub services.

2.

Open the file application-prod.yml, which is typically located in C:\Program Files\Datawatch Monarch Swarm,
and then add the following properties:

IMPORTANT: Base paths are case-sensitive. When specifying a base path to use for file system connections,
ensure that the case for all folder names, including the drive letter, are provided exactly as formatted.
Example:

NOTES

•

All root paths must be unique.

•

Multiple root paths can be specified by using the properties root-path, rootpath2, root-path3, etc.

•

If multiple paths contain the same start path (e.g., path1: C:\Program
Files\Knowledge Hub\File System1; path2: C:\Program Files\Knowledge Hub\File
System1\Reports), these paths are divided into a root path (i.e., C:\Program
Files\Knowledge Hub\File System1) and an extended path (\Reports).
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3.

Restart all Knowledge Hub services, log into Knowledge Hub 2.4.1, and then click Connections.

4.

Select a file system connection from the Connections list to edit it.

5.

Use the Base Path drop-down to select the correct file system base path for the connection. Add an extended path
if necessary.

6.

Save the connection.

If the necessary base paths are not specified in the config file, the warning “There are no base paths defined.
Please contact the administrator.” is returned:
❑

When using a pre-defined file system connection

❑

When adding/editing a data source from a pre-defined file system connection

❑

When opening a workspace with a data source from a pre-defined file system connection:

❑

When exporting a data source from a pre-defined file system connection
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[9] TROUBLESHOOTING
KNOWLEDGE HUB
The items in this section describe troubleshooting measures you may need to take when working with Knowledge
Hub.

STARTING THE SERVICE
In some instances, Knowledge Hub may not be accessed from any browser because the service has not been
started. This may occur when the operating system of the machine in which the application is installed is updated or
restarted.
If the Knowledge Hub application does not start automatically, you may need to start it manually.

Steps:
1.

Go to Control Panel > System and Security > Administrative Tools > Services.

2.

In Services window that displays, locate the Knowledge Hub (Datawatch Monarch Swarm) item and then click
Start in the left-hand pane of the Services list.

3.

Repeat Step 2 for the Knowledge Hub (Datawatch Monarch Swarm) Data Engine service.

NOTES

You can also select the item, right-click on your mouse, and then select Start
from the options that display.
The Knowledge Hub services may be started in any order.
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4.

Close the Services window.
You may need to wait a few minutes to allow these services to restart completely.
The Knowledge Hub login page can now be loaded as usual.

BACKING UP THE KNOWLEDGE HUB
POSTGRESQL DATABASE
Backing up your Knowledge Hub databases is necessary to ensure that all of your data, workspace definitions,
security settings, and the like are preserved when PostgreSQL or the application itself is upgraded or reinstalled.
When Knowledge Hub is installed, PostgreSQL 11 and its management tool, pgAdmin4, are concurrently installed.
This tool can be used to back up and restore your database. The PostgreSQL database includes information on,
among others, users, data source/workspace/connection metadata, and permissions.

NOTES

The binary path to the directory containing the PostgreSQL utility programs
(e.g., pg_dump, pg_restore, etc.) must be specified in File > Preferences >
Paths > Binary paths before you can back up a database. Contact your system
administrator if you need help doing so. More information on this setting may be
found here.
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Steps:
1.

In C:\Program Files\PostgreSQL\11\pgAdmin 4\bin, double-click on the pgAdmin4 application to launch it.
The pgAdmin4 user interface displays in your browser.

2.

Expand the Servers node and then double-click PostgreSQL 11.
A login dialog displays.

3.

Enter the password for the user postgres and then click OK. By default, the PostgreSQL password is postgres.
If, however, you specified a different password when PostgreSQL was installed, you must provide this password
here.
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You are connected to the PostgreSQL server, and several items display below it.

4.

Expand the Databases node and then select a Knowledge Hub database. Right-click on it and then select Backup
from the options that display. Knowledge Hub uses two databases (i.e., dataengine_api and newserver [specified
when the application is first installed]); both databases must be backed up.
The Backup dialog displays.

5.

Provide the information required in the General tab of this dialog and then click on the Dump options tab.

NOTES

Save the information you provide in the General tab of the Backup dialog. You
will need to provide this information when restoring the database at a later time.
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6.

Move the switches in the Sections box to specify which portions of the database should be backed up.

7.

Move the switches in the Type of Objects box to specify which database components to back up.

8.

Move the switches in the Do not save box to specify which database components to exclude from the backup.

9.

Move the switches in the rest of the field boxes provided in the tab to specify other settings for your backup.

10. Click Backup at the bottom of the dialog when you are finished. Otherwise, click Cancel to abort the backup
operation.
A popup dialog similar to that shown below displays to indicate successful or unsuccessful backup.

Details of the backup operation, whether successful or not, may be viewed in the Process Watcher, which is
launched by clicking on the Click here for details link provided in the popup.
By default, your backup will be located in C:\Program Files\PostgreSQL\11\pgAdmin 4\bin.
More information on how to backup databases in PostgreSQL may be found here.
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RESTORING THE KNOWLEDGE HUB
POSTGRESQL DATABASE
When PostgreSQL or Knowledge Hub is upgraded or reinstalled, you may need to restore a previously backed-up
Knowledge Hub database to continue working with your data.
The pgAdmin4 tool is also used to restore Knowledge Hub databases.

Steps:
1.

Run the pgAdmin4 tool and log into the PostgreSQL 11 server.

2.

Create a new Knowledge Hub database. If this database already exists, select it.

3.

Right-click on this database and, from the options that display, select Restore.
The Restore dialog displays in your browser.

4.

Provide the information required by each of the fields in the General tab of this dialog. This information should
match the details you specified in the General tab of the Backup dialog when you backed up your database.

5.

Click the Restore options tab.

6.

Use the switches provided in each of the field boxes in this tab to specify how your database should be restored.

7.

Click Restore at the bottom of the dialog when you are finished. Otherwise, click Cancel to abort the restore
operation.
A popup window displays to indicate successful or unsuccessful restoration.
Details of the restore operation, whether successful or not, may be viewed in the Process Watcher, which is
launched by clicking on the Click here for details link provided in the popup.
More information on how to restore databases in PostgreSQL may be found here.
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PRODUCT SUPPORT
Product support for Knowledge Hub may be obtained here.
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